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Notice

1.

13.
14,

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT
TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or

transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com

www.renesas.com/contact/.

Trademarks

Renesas and the Renesas logo are trademarks of Renesas
Electronics Corporation. All trademarks and registered trademarks
are the property of their respective owners.

© 2022 Renesas Electronics Corporation. All rights reserved.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement
tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be
touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LS| are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in
a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level
at which resetting is specified.

3. Input of signal during power-off state
Do not input signals or an 1/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements.
Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally
in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an
associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible.

5. Clock signals
After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced
with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between ViL (Max.)
and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level
is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vii (Min.).

7. Prohibition of access to reserved addresses
Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LS| is not guaranteed.

8. Differences between products
Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of
internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.

e The useris advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use the e? studio IDE to develop
and debug software for the RSK platform. It is intended for users designing sample code on the RSK platform,
using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to load and debug a project in e? studio, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX660 microcontroller may be found in ‘RX660 Group User’s Manual: Hardware’ and within the
provided sample code. The setup procedure for the RSK Web installer is described in the Quick Start Guide.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur
within the body of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to
the text of the manual for details.

The following documents apply to the RX660 Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK Renesas Starter Kit for R20UT5017EG
hardware. RX660 User’s Manual
Tutorial Manual Provides a guide to setting up RSK environment, Renesas Starter Kit for R20UT5021EG
running sample code and debugging programs. RX660 Tutorial Manual
Quick Start Guide Provides simple instructions to setup the RSK and Renesas Starter Kit for R20UT5022EG

run the first sample. RX660 Quick Start Guide
Smart Configurator Provides a guide to code generation and importing Renesas Starter Kit for R20UT5023EG
Tutorial into the e? studio IDE. RX660 Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSK. Renesas Starter Kit for R20UT5016EG
RX660 Schematics
Hardware Manual Provides technical details of the RX660 RX660 Group User’s RO1UHO0937EJ
microcontroller. Manual: Hardware




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
E1/E2 Lite Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
PLL Phase-locked Loop
Pmod™ Thi§ is a Digilent Pmod™ qupatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface Specification
PSU Power Supply Unit
RAM Random Access Memory
ROM Read Only Memory
RSK Renesas Starter Kit
RTC Real Time Clock
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TFT Thin Film Transistor
UART Universal Asynchronous Receiver/Transmitter
uUSB Universal Serial Bus
WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.


https://reference.digilentinc.com/reference/pmod/specification?redirect=1
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LENESAS

1. Overview

1.1 Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to get the RSK

tutorial started, and basic debugging operations.

1.2 Features

This RSK provides an evaluation of the following features:
« Renesas microcontroller programming

« User code debugging
o User circuitry such as switches, LEDs and a potentiometer

Through the provided set of sample applications.

The RSK board contains all the circuitry required for microcontroller operation.

R20UT5021EG0100 Rev.1.00
Jan.17.2022 RENESAS
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Renesas Starter Kit for RX660 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, the most common questions asked about using a Renesas
Starter Kit (RSK). The tutorials help explain the following:

e How do | compile, link, download and run a simple program on the RSK?
e How do | build an embedded application?
e How do | use Renesas tools?

Files referred to in this manual are installed using the project generator as you work through the tutorials. The
tutorial examples in this manual assume that installation procedures described in the RSK Quick Start Guide
have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

Due to the project generator, it is possible that line numbers for source code illustrated in this document do not
match exactly with that in the actual source files. It is also possible that the source address of instructions
illustrated in this manual differ from those in user code compiled from the same source. These differences are
minor, and do not affect the functionality of the sample code nor the validity of this manual.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction
to e? studio, the compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-
depth information.

21 Smart Configurator Plugin

The Smart Configurator plugin for the RX660 has been used to generate the sample code discussed in this
document. Smart Configurator for e? studio is a plugin tool for generating template ‘C’ source code and
project settings for the RX660. When using Smart Configurator, it supports the user with a visual way of
configuring the target device, clocks, software components, hardware resources and interrupts for the project;
thereby bypassing the need, in most cases, to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Smart Configurator’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where xxx’ is an acronym for the relevant MCU feature, for example
‘CMT’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. However, these files require custom code to be added between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

Note: If code is added outside the above user code area, it will be lost if code generation is executed again
with Smart Configurator.

In this RSK sample project, only some functions are used.
For other useful features, refer to the https://www.renesas.com/smart-configurator.

R20UT5021EG0100 Rev.1.00 e
Jan.17.2022 RENESAS
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Renesas Starter Kit for RX660 3. Tutorial Project Workspace

3. Tutorial Project Workspace

3.1 Introduction

e? studio is an open source integrated development tool that allows the user to write, compile, program and
debug a software product on many of the Renesas microcontrollers.

3.2 Connecting the Debugger

The Quick Start Guide provided with the Renesas Starter Kit board gives detailed instructions on how to
connect the E2 Lite to the host computer. The following assumes that the steps in the Quick Start Guide have
been followed and the E2 Lite drivers have been installed.

e Fit the PMOD LCD display to the board. Ensure all the pins of the connector are correctly inserted in the
socket.

e Connect the E2 Lite Debugger to a free USB port on your computer.

e Connect the E2 Lite Debugger to the target hardware ensuring that it is plugged into the connector
marked ‘E2 Lite’.

3.3 Starting e? studio and Importing Sample Code

To use the program, start e2studio:

Windows™ 8.1: From Apps View @ click ‘Renesas Electronics e2studio > e2 studio icon

Windows™ 10: Start Menu > All Apps > Renesas Electronics RSKRX660 > e2 studio
Windows™ 11: Start Menu > All Apps > e2 studio

e Start e? studio by selecting it from the @
Windows™ Start Menu. The first dlalog box Select a directory as workspace
to appear W||I be the Workspace Launcher. e? studio uses the workspace directory to store its preferences and development artifacts.

e Click ‘Browse’ and select a suitable location
to store your workspace, using the ‘Make
New Folder’ option as necessary. Click
‘Lau nCh’ . [ Use this as the default and do not ask again

» Recent Workspaces

Workspace: |C¥Workspace v Browse.

e The e? studio Welcome splash screen will
appear. Click the ‘Workbench’ arrow button
on the far right (circled in the screenshot ) ¢ e
opposite).

actor Navigate Search Project RenesasViews Run Window Help

enesas website

Open a file from the filesystem

R20UT5021EG0100 Rev.1.00 REN ESNS Page 10 of 23
Jan.17.2022



Renesas Starter Kit for RX660 3. Tutorial Project Workspace

¢ Once the environment has initialized, select
‘Import project...’ from the ‘Project Explorer’

window. There are no projects in your workspace.
To add a project:

5 Project Explarer =l <}==|,> l_f| E = B

@ Create a new Makefile project in a
directory containing existing code

@ Create a new C or C++ project

[ Create a project...
I,ﬁ, mport projects.., I

e The Import dialog box will be shown. 3 import o x|
Expand the ‘General’ folder icon, and select Select \‘
‘EXiSting PrOjeCtS into Workspace,, then Create new projects from an archive file or directory. u
click ‘Next'.

Select an import wizard:
[tpe fiter text
~ & General ~
[P Archive File
% Existing Projects into Workspace
J File System

[T} Preferences
4 Projects from Folder or Archive
= Rename & Import Existing C/C+ + Project into Workspace
T Renesas CCRX project conversion to Renesas GCC RX
T Renesas CS+ Project for CATBKOR/CATBKD
= Renesas CS+ Project for CC-RX and CC-RL
w# Renesas GitHub FreeRTOS (with loT libraries) Project
@ Sample Projects on Renesas Website
& C/C++
& Code Generator
& Install

@ Back Next > Finish Cancel
e The Import dialog box will allow you to & import o x
specify a project to import. Click the Import Projects —
‘Browse, button and Iocate the fO”OWIng Select a directory to search for existing Eclipse projects. d
directory:
@) Select root directory: | C¥Workspace¥RSK¥RSKRX660 ~ | Browse...
O Select archive file: Browse...
C:\Renesas\Workspace\RSK\RSKRX660 P
Application (C:¥Workspace¥RSK¥RSKRX660¥Application) ~ Select All
Async_Serial (C:¥Workspace¥RSK¥RSKRX660¥Async_Serial}
e Ensure that the ‘Copy projects into Low._ Power Mode (C:#¥Workspace¥RSK¥RSKRXGE0¥Low_Power Mode) | L DeselectAll
, . L . RTC (C¥Workspace¥RSK¥RSKRXE60¥RTC) Refresh
Workspace Optlon IS tICkedl and then C“Ck System_Bootloader_Application (C:¥Workspace¥RSK¥RSKRX660¥Syste
‘F|n|Sh’ System_BootLoader (C:¥Workspace¥RSK¥RSKRX660¥System_BootLoac
System_Input_Capture (C:¥Workspace¥RSK¥RSKRX660¥System_Input_C
Timer PWM (C:¥Workspace¥RSK¥RSKRX660¥Timer PWM)
[] Tutorial (C:¥Workspace¥RSK¥RSKRX660¥Tutorial) M
< >
Options

[] search for nested projects

Copy projects into workspace

[] Close newly imported projects upon completion
[[] Hide projects that already exist in the workspace

Working sets

[CJAdd project to working sets New...
Select.
e Click on Tutorial from the list of projects in =5 System_Input_Capture
the ‘Project Explorer’ on the left-hand side. == Timer PWM
=5 Tutorial
R20UT5021EG0100 Rev.1.00 :{ENESAS Page 11 of 23
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Renesas Starter Kit for RX660 3. Tutorial Project Workspace

34 Build Configurations and Debug Sessions

3.41 Build Configuration
The e? studio workspace will be created with two build configurations: ‘HardwareDebug’ and ‘Release’.

Release

This Build Mode has optimisation turned on, and provides little debug information. The C code execution may
appear to be out of order, due to the way the compiler optimises the code. This build configuration is intended
for final ROM-programmable code.

HardwareDebug
This Build Mode has all optimisation turned off, and provides full debug information. This is the best
configuration to use whilst developing code as C code execution will be linear.

e Click the top level ‘Tutorial’ folder again, and . - . .
then the arrow next to the build button s i WO v %, OF 0D @
(hammer icon) and select the @ >

X 1 HardwareDebug (Debug on hardware)
‘HardwareDebug’ option.

2 Release (Release - Mo Debug)

e e2studio will then build the code.

R20UT5021EG0100 Rev.1.00 REN ESNS Page 12 of 23
Jan.17.2022




Renesas Starter Kit for RX660 3. Tutorial Project Workspace

3.4.2 Debug Configuration

e Click the arrow next to the debug button (bug
icon), as highlighted by the red circle.
Select ‘Debug Configurations’.

Debug As 3
Debug Configurations...

Organize Favorites...

e The ‘Debug Configurations’ dialog box will {8} Debug Configurations
appear. Click the small arrow next to the P 3 s
. . reate, manage, and run configurations
‘Renesas GDB Hardware Debugging’ option. 9 g
e The debug configurations for each project will

appear. Select the entry for the “Tutorial @ oY - P

HardwareDebuQ,' type filter text l - Press the ‘Nev
| Renesas GDB Hardware Debugging P - Press the 'Nev
E |
£ Application HardwareDebug B - Pre=s the Exp
[E7 Application Release
7 Async_Serial HardwareDebug - Press the ‘Dug
[ Async_Serial Release % - Press the 'Del
" Low_Power_Mode HardwareDebug .
[ Low_Power_Mode Release o i
[E7 RTC HardwareDebug - Editor view a
[T RTC Release il - Select launch
[E7 System_BootLoader_Application HardwareDebug s
[E7 System_BootLoader_Application Release = et kX
[E7 System_BootLoader HardwareDebug R - Select launch
E System_BootLoader Release
[E7 System_Input_Capture HardwareDebug Configure launch p
£ System_Input_Capture Release
EY Timer_PWM HardwareDebug
[E¥ Timer_PWM Release
¥ Tutorial HardwareDebug
[ Tutorial Release

The debug configurations control page will
then show for the Tutorial project. Change
the main tab to ‘Debugger’ and then select
‘Connection Settings’ on the secondary tab
bar that appears.

There is no need to change the debugger
settings as they are preconfigured with the
Tutorial project. Please check “Power Target
From The Emulator (MAX 200mA)” is “Yes”.

Refer to the RSKRX660 User’s Manual for
details of power supply configuration.

Note: e? studio will display a warning
if you attempt to connect with an
incorrect power supply setting.

Click the ‘Debug’ button to continue.

e? studio will be connected to the debugger
and download the code to the target.

e

| Create, manage, and run configurations

ype filter text

X/ 27 v

‘a Applet ~
a Application

nch Group

mote Java Application

nesas GDB Hardware Debuggi
Application HardwareDebug
Application Release

Async Serial HardwareDebug
Async_Serial Release
Low_Power Mode HardwareD
Low_Power Mode Release
RTC HardwareDebug

RTC Release
System_BootLoader_Applicatic
System_BootLoader Applicatic
System_BootLoader Hardware:
System_BootLoader Release
System_Input_Capture Hardwa
System_Input_Capture Release.
Timer_PWM HardwareDebug
Timer_PWM Release

Tutorial HardwareDebug
Tutorial Release

nesas Simulator Debugging (R v
< >

Filter matched 29 of 31 items

@

Name: | Tutorial HardwareDebug

wain [EHSEIEN > Starup| Tl Common| & Source

Debug hardware: E2 Lite (RX)

GDB Settings Connection Settings Debug Tool Settings

v Clock

Main Clock Source EXTAL v
Extal Frequency[MHz] 24
Operating Frequency [MHz] 120000
Permit Clock Source Change On Writing Internal Flash Memory Yes v
 Connection with Target Board
Emulator (Auto) =
Connection Type Fine v
JTag Clock FrequencyIMHz] I
Fine Baud Rate[Mbps] 150 v
Hot Plug No &
v Power
Power Target From The Emulator (MAX 200mA) Yes v
Supply Voltage (V)
 CPU Operating Mode
Register Setting Single Chip v
Mode pin Single-chip mode v
Change startup bank
Startup bank v

~ | Target Device: RSF56609H

Close

R20UT5021EG0100 Rev.1.00
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3. Tutorial Project Workspace

e Afirewall warning may be displayed for ‘e2-
server-gdb.exe’. Check the ‘Private
networks, such as my home or work network’
box and click ‘Allow access’.

e Auser account control dialog may be
displayed. Enter the administrator password
and click ‘Yes’.

™ Windows Security Alert

O Windows Firewall has blocked some features of this app

Windows Firewall has blocked some features of E2 Server GDB on all public, private and domain

networks.
@ Name:
Publisher: Renesas Electronics Europe Ltd
Path: C:'yenesas'e2_studio\debugcompyx\e2- server-gdb.exe

Allow E2 Server GDB to communicate on these networks:
[+] Domain networks, such as a workplace network

[Private networks, such as my home or work network

[[Public netwarks, such as those in airports and coffee shops (not recommended
because these networks often have little or no security)

What are the risks of allowing an app throudh a firewall?

E;éllow access Cancel

e After downloading the code a dialog box will
appear asking if you would like to switch to
the ‘Debug perspective’. Click ‘Remember
my decision’ to prevent this dialog box from
appearing in future, then click ‘Yes’.

e e? studio will load the new perspective, which
is optimised for debugging.

ﬁ Confirm Perspective Switch Pad

e This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective supports application debugging by providing views for displaying
the debug stack, vanables and breakpoints.

Switch to this perspective?

|:| Remember my decision

o
e To change back to the default ‘C/C++’ ) Open Perspective 0O W
perspective, from the menu bar select
Window > Perspective >Open Perspective > BBC/Cre (default
Other or click the Open Perspective button. *H Code Generator
1 Debug
@ &' Java
e The ‘Open Perspective’ dialog box will ¥ Java Browsing
appear. Click on the desired perspective to t2’ Java Type Hierarchy
select it then ‘OK’. {4 Resource
e Perspectives can also be switched with the = Scripting
following shortcuts. # Smart Configurator
& Team Synchronizing
% C/C++ ﬁ Debug
e The perspective should be 'Debug’, as it will
be needed in the next section.
Cancel

3.5 Running the Tutorial

e Refer to the description.txt file in the doc folder of Tutorial project for instructions on how to configure the

RSK and run the sample code.

e Once the code has been downloaded, click ‘Resume’ button
main function is set as the program entry point by default.

instruction in the main function.

e Click the ‘Resume’ button

in the ‘Debug’ perspective to run the rest of the code.

e ltis recommended that you run the entire tutorial demo first, before continuing to debug it.

R20UT5021EG0100 Rev.1.00
Jan.17.2022
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4. Reviewing the Tutorial Program

4. Reviewing the Tutorial Program

This section will look at each section of the tutorial code and basic debugging functionality in e? studio.

4.1 Program Initialization

Before the main program can run, the microcontroller must be configured. The following parts of the tutorial
program are used exclusively for initializing the RSK device so that the main function can execute correctly.
The initialization code is run every time the device is reset via the reset switch or from a power cycle.

'hwsetup.c'.

v & smc_gen
& Config_CMTO
= Config_CMT1
& Config_CMT2
& Config_ICU
& Config_PORT
= Config_S12AD0
& Config_SCO
& Config_SCl6
& general

v & r_bsp

= board

v = genernc_r660
it hwsetup.c
i hwsetup

E

¢

e Build and download the code as shown in M Project Explorer = B
Section 3.4. .
On the Project Explorer tab d th S A
o n the Project Explorer tab expand the w4 ;
‘Tutorial’ folder by clicking on the arrow l':: s
next to the folder icon, as highlighted by & Low_Power_Mode
the red circle. i RTC
=5 System_BootlLoader
% System_Bootloader_Application
= Systern_Input_Capture
=5 Timer_PWM
Oé Tutorial [HardwareDebug]
e Click the arrow next to the ‘src’ folder to e’ 0 %
show the source files.
e Expand the folder path 'smc_gen' -> M Project Explorer x S o
'r_bsp' -> 'board' -> 'generic_rx660' as ol Includes 1
shown and double click on the file v 5 sic

£
e Breakpoints can be set by double clicking T R KL IR
at the left-hand edge of the source #if BSPCFG Eli;;Fizﬁ;A‘lrr;Rf;ElL‘éET: e
window. On the line with instruction \ R.s;:;! l_"'fg“-'“"' e initi
‘R_Systeminit();, double click next to the ‘s oty _
vertical line to set a breakpoint. } /% End of function peripheral modules_enable() */
R20UT5021EG0100 Rev.1.00 REN ESNS Page 15 of 23
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4. Reviewing the Tutorial Program

e Click the ‘Resume’ button in the Debug
perspective (or press [F8]) to run the code
up to this breakpoint.

ll

Note: The program counter is indicated by the
blue arrow next to the breakpoint.

L f02003]

static void peripheral_modules_enable(veid)

Add code here to enable
#if BSP_CFG_CONFIGURATOR_SELECT
Smart Configurator initialization functior
R_Systeminit();
#endif

Y/ unction peripheral_modules_enable() *

e Click the ‘Step Into’ button (or press [F5]),
to step into the ‘R_Systeminit’ function.

=L

e The ‘R_Systeminit’ function calls several
initialization functions which configure the
MCU for normal operation. This includes
input/output ports, and system clocks.

e The user can step through all the
initialization code by clicking the ‘Step
Into’ icon and reading the code however
for the purpose of this manual, it will be
skipped.

e Click the ‘Resume’ button, to run the code
up to the main function.

0

52|

- Joid R_Systeminit(void)
{

* Enable writing to registers r
SYSTEM.PRCR.WORD = @xA50BU;

Enable writing to MPC pin function control registers *
MPC.PWPR.BIT.BOWI = @U;
MPC.PWPR.BIT.PFSWE = 1U;

* Write @ to the target bits in the POECR2 registers */
POE3.POECRZ.WORD = ©x@eoau;

Initialize clocks settings *
R_CGC_Create();

* Set peripheral settings *
R_Config_PORT_Create();
R_Config_CMT@_Create();
R_Config_CMT1_Create();
R_Config_CMT2_Create();
R_Config_ICU_Create();
R_Config_SCI1@_Create();
R_Config S12AD@ Create();
R_Config SCI6_Create();

For further details regarding hardware configuration, please refer to ‘Renesas Starter Kit RX660 User’s

Manual’ and ‘RX660 Group User's Manual: Hardware’.

R20UT5021EG0100 Rev.1.00
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Renesas Starter Kit for RX660 4. Reviewing the Tutorial Program

4.2 Main Functions

This section will look at the program code called from within the main function, and how it works. It is
necessary to connect the G1CUSBO port on the RSK to a PC USB port and open a terminal emulation
program, such as Tera Term, with the settings:

Baud Rate: 19200,

Data Length: 8, Parity Bit: None, Stop Bit: 1, Flow Control: None
For information on installation of the RSK virtual COM port driver, refer to the file ‘description.txt’ in the doc
folder of the e? studio Tutorial project.

e Select and right click the : void'msin (vadd);
‘R_Config_SCI10_Serial_Receive’ E e o s
function call and select ‘Run to Line’ to ~Rh e
execute thg program up to this line. The & reronsll | a_s#}}éﬂlx;.i{(j}'
‘R_LCD_Init’ function call enables and

5et the call 2 is pressed *

Configures the LCD panel, and Ff0094 R_SLI'IT(H_SET"VI'ESiélﬂ.lll;a..(k-(;.bl_‘sv\.li;(h_‘;:;ri‘e‘;s);:“
‘R_LCD_Display’ will write “RSKRX660 " R i
Tutorial Press Any Switch” onto the LCD. 100 00950 R_LCD_Init(); '

isplays the application name on the debug LCD.
R_LCD Display(®, (uint8_t *)" RSKRX66@ ");
R_L(D_Dis.blay(], (uint8_t *)" Tutorial “);
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");

R_Config S124D8_Start();

e Set a breakpoint on the B et s g
‘R_Config_SCI10_Start’ function call by bill6 fffo097c | R_Config SCT16_Serial Receive((uints t *)&g_rx_char, 1);
double-clicking in the breakpoint column.

e Click the ‘Step Into’ button to step into the | (°..; R Config SEL18 Start();
‘R_Config_SCI10_Serial_Receive’
function.

L,

° The program COUnter ShOUld nOW mOVe B fffe 2\[)7\].-’-&“1\ R_Config_SCI1@_Serial_Receive(uint8_t * const rx_buf, uintlé_t rx_num)
into the ‘R_Config_SCI10_Serial_Receive’ | 7./ " R —
function definition. This function is an API i 10
function provided by the Smart PG| ) stetss O ARGROG
Configurator. It sets up the SCI interrupt .
handler code to receive a specified ok PR
number of bytes into a receive buffer. ki o e e
Once the specified number of bytes has ; .
been received, the interrupt handler code ioiras | Mt

calls a callback function as shown later on
in this section.

e For full details on how to configure a
project using Smart Configurator refer to
the Smart Configurator Tutorial Manual.

e Click the ‘Resume’ button to resume
program execution.

0

R20UT5021EG0100 Rev.1.00 REN ESNS Page 17 of 23
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Renesas Starter Kit for RX660 4. Reviewing the Tutorial Program

» The program counter should come to a halt 6 frioore  AMEESRRMRSRRNREREN (vints + *rdq_rx. char. 1);
at the ‘R_Config_SCI10_Start’ function. . e o

e Step over the function by clicking the ‘Step M GEEEE | R Config SCI10 Start();

Over’ button. Alternatively, press [F6].
=

The ‘R_Config_SCI10_Start’ function enables

the UART interrupts. The program then

proceeds to the main while(1U) loop. The code

inside the loop waits for user input from either

the SCI or RSK switches, and then performs

an A/D conversion.

e Locate the function call to ‘lcd_display_adc’ ()
inside the Wh”e |00p_ = uint16_t adc_result;

e Set a breakpoint on the ‘lcd_display_adc’ B R ey - CTVerTion flee to be set
function call by double-clicking in the break 2 b e B S T Y
point Column. 29 fffeeosf adc_result = get_adc();

13 1(dlélgpldy:;d(IEadclltesul;I), o

¢ In the Project Explorer pane, locate the file v &5 Tutorial [HardwareDebug]
‘Config_SCI10_u§er.c’ and double-click to ¥ Binaries
?upnecr:iéze source file. Scroll down to the i

‘r_Config_SCI10_callback_receiveend’. v & src
~ (= smc_gen
& Config_CMTO
& Config_CMT1
& Config_CMT2
& Config_ICU
& Config_PORT
= Config_S12AD0
~ = Config_SCI10
¢ Config_SCI10_userc
& Config_SCI10.

W Config_SC10R

&= Config_SCl6
& general
e Set a breakpoint on the line of code inside R cAARFRTLL Gaddr, ontig AT sITUGk. pecatioamjuels)
the ‘r_Config_SCI10_callback_receiveend’ i % start user code for r_Config SCI10_callback_receiveend. D
function as shown opposite. : /% Check the contents of g rx_char *
00 ££fo o if (('c’ == g_rx_char) || ("C" == g_rx_char))
o Continue to execute the program by clicking | & na e
the ‘Resume’ button. 203 }
y 110 receive buffer and callback function again */

{* Set up SC eceive if E ca C aga
R_Config_SCI1@_Serial_Receive((uint8_t *)&g_rx_char, 1);

1 A S
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4. Reviewing the Tutorial Program

¢ In the terminal emulation window, press the
‘c’ button on the keyboard.

e The program will halt at the breakpoint in
the ‘r_Config_SCI10_callback_receiveend’
function as shown opposite. Remove the
breakpoint by double-clicking on the
breakpoint column.

e Continue to execute the program by clicking
the ‘Resume’ button.

e

I

- PLEK

if (("c" == g_rx_char) || ('C" == g_rx_char))

g adc_trigger = TRUE;
}

e The program will halt at the breakpoint in
the main while loop.

o Remove the breakpoint by double-clicking
on the breakpoint column. Continue to
execute the program by clicking the
‘Resume’ button.

e

/* Display the result on the LCD *
lcd_display adc(adc_result);

Ie crement the adc count and display
if (16 == ( ++s_adc_count))
s_adc_count = @;

led_display_count(s_adc_count);

The program proceeds to display the result of the A/D conversion on the LCD and in the terminal window. In
addition, the running count of A/D conversions performed is displayed in binary form using LEDs 0-3 on the
RSK. Adjust the potentiometer and press SW1, SW2 or SW3 on the RSK and an additional A/D conversion

will be performed.

e Press the ‘Suspend’ button to halt program

execution. LiLJ
e To change back to the default ‘C/C++’ Window Help
perspective, from the menu bar select New Window Bis w |0 00 W i FAE L
Window > Perspective >Open Perspective Editor > |
‘ ’ Appearance »
> ‘C/C++". B (<l Config_SCI10.c
Show View
Perspective > [ Open Perspective > B ¢/Ces
Navigation » Customize Perspective... ;J Java
§ lava Browsing
Prefermnces Save Perspective As..
EYLEE o Reset Perspective... ] Other..
{ Setup Views For Device ¥
Close Perspective prform an A/D convers
Close All Perspectives
e Alternatively, click on the ‘C/C++’ button in =
the top right corner of the screen, as shown el C/C++ | 4+ Debug

opposite.

e This is the extent of the tutorial code.

For further details regarding hardware configuration, please refer to ‘Renesas Starter Kit for RX660 User's Manual’ and

‘RX660 Group User’s Manual: Hardware’.

The E2 emulator Lite features an advanced logic-based event point trigger system, and full instruction on its use is outside
the scope of this tutorial. For further details, please refer to the E2 Emulator Lite User’'s Manual.
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5. Additional Information

Technical Support

For details on how to use e? studio, refer to
the help file by opening e? studio, then
selecting Help > Help Contents from the | &'~ B Wi i

menu bar. () Help Contents
Search

Window Help

Show Context Help |

Parts of the sample code provided with the RSKRX660 can be reproduced using the Smart Configurator tool.
Smart Configurator is included as a plug in with e? studio.

Source files and functions generated by Smart Configurator are prefixed with r_’ and ‘R_’ or ‘Config_’,
respectively.

Technical Support
For information about the RX660 Group microcontrollers refer to ‘RX660 Group User’'s Manual: Hardware’.

For information about the RX assembly language, refer to ‘RX Family User’s Manual: Software’.

Technical Contact Details
America: techsupport.america@renesas.com

Europe: https://www.renesas.com/eu/en/support/contact.htmi
Global & Japan: https://www.renesas.com/support/contact.html

General information on this product can be found on the Renesas website at:
https://www.renesas.com/rskrx660

General information on Renesas Microcontrollers can be found on the Renesas website at:
https://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe GmbH.

© 2022 Renesas Electronics Europe GmbH. All rights reserved.
© 2022 Renesas Electronics Corporation. All rights reserved.
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